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CAREER CENTER  

RESUME WRITING PACKET 

Use this packet to help you write your 

resume. To get started: 

Have the job description in front of you 

Complete the first 3 pages of this packet 

Identify the type of resume to create 

Use the samples in this packet for help 

Use a blank word processing document 

DO NOT use a resume template 

Career Success Guides and Counselors are available for help! 

Call the Career Center at 909-652-6511 for availability 
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Before you begin writing your résumé, it is important to compile a complete history of your work 

experience and educational background. You never know how critical a past experience may be until 

you compare it to the rest of your history and analyze it for current relevance.  Print this worksheet and  

use it to organize a list of everything you have ever done (in relation to the development of your present 

knowledge, skills, and abilities). The point at this stage is not to evaluate your experiences, but to simply 

identify them and assemble them into a readable layout. 

TYPES OF EXPERIENCE

All Employment History: 

Position Employer Location (City, State) Dates 

Duties and Achievements 

Position Employer Location (City, State) Dates 

Duties and Achievements 

Position Employer Location (City, State) Dates 

Duties and Achievements 

(Use additional copies of each page as necessary.) 

Résumé Writing – First Steps 
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Other Experience: 

Use this section to list all other past experiences, no matter how unimportant they may seem. Take a 

moment to consider each of the following categories and then list each activity in the fields below: 

volunteer, military, community service, church, clubs, etc… Be sure to describe your specific role in 

each activity, especially if your role involved leadership or a high degree of responsibility. 

 
Activity Organization Location (City, State) Dates 

    

Description of Activity 

 

 
Activity Organization Location (City, State) Dates 

    

Description of Activity 

 

 
Activity Organization Location (City, State) Dates 

    

Description of Activity 

 

 

Awards and Honors: 

List any awards and/or honors that you have received and when you received them. Include recognition 

such as employee of the month, dean’s honor roll, perfect attendance, etc… 

 
Type of Recognition Date Received 

  

  

  

 

Additional Knowledge, Skills, and Abilities: 

List any additional knowledge, skills, and abilities that you possess which have not been listed anywhere 

else on this worksheet. Include specifics regarding computer skills, special talents, unique abilities, 

certifications (CPR, food handler, CBEST, etc…) or anything else that you have been trained to do. 
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EDUCATION 
 

 

Complete the following fields regarding your educational background and be sure to include anything that 
may be currently in progress. 

 
Name of School Location (City, State) 

  

Type of Degree Major / Course of Study Date Received (or “Anticipated…”) 

   

Courses relevant to current job search 

 

 

Name of School Location (City, State) 

  

Type of Degree Major / Course of Study Date Received (or “Anticipated…”) 

   

Courses relevant to current job search 

 

 
Name of School Location (City, State) 

  

Type of Degree Major / Course of Study Date Received (or “Anticipated…”) 

   

Courses relevant to current job search 

 

 

Remember, the purpose of a résumé is to showcase your qualifications for a particular position with the goal 

of securing an interview. In today’s ever competitive job market it is important to target your résumé to each 

specific job that you are applying for. Employers are not just looking for qualified people; they are looking  

for the most qualified person who demonstrates the potential of bringing something special to the 

organization. 

 

The next step is to find an actual job description for the type of work that you plan to apply for. This may be 

an actual local advertisement that you are seriously considering, or just something similar that you find  

online. Use the job description to make a list of the required and desirable qualifications for this line of work 

and write them here using the same language from the job posting: 
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ROLE MATCH VALUE MATCH SKILL MATCH 

Your “target job title” should match the title that’s 
being advertised and go toward the top of your 
resume to catch the eye of the hiring manager. 

Find overlap between your previous 
responsibilities and qualifications to show what 
value you can bring to this organization. 

Identify the hard and soft skills from the job ad and 
mirror the same language in your resume to show 
that you’re equipped to do the job. 
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  Anita Job (909) 555-5555  anitajob@email.com  620 Havana Street, Chino, CA 91710  

PROFESSIONAL QUALIFICATIONS 
 

• Recent graduate with experience in accounting and office management 

• Highly organized, detail oriented, and data driven 

• Comfortable working on teams and independently 

• Effective problem solver who utilizes critical thinking to develop results driven solutions 

EDUCATION 
 

Associate of Arts Degree in Accounting Anticipated Graduation, May 2019 
Chaffey College, Rancho Cucamonga, CA 

Related Coursework: Computer Keyboarding, Microsoft Office Word-Expert, Office Systems and Procedures, and 

Administrative Office Management 

SKILLS & INTERESTS 
 

Technical: MS Excel, Word, PowerPoint, Access, QuickBooks Pro, JavaScript 
Language: Fluent Spanish, Beginner Italian 

Interests: Accounting, managing data, preparing taxes 

RELATED EXPERIENCE 
 

Payroll Officer September 2017- Present 
ABC Company, Inc., Los Angeles, CA 

• Created a certified wages payroll handbook and oversaw its completion to ensure quality payroll procedures 

• Collected, inspected, and processed over 60 employees’ timesheets daily 

• Calculated and recorded hourly rates for private wages and state and federal certified wages 

• Updated employee records and generated daily reports using QuickBooks Pro accounting software 

Computer Information Systems Help Desk June 2015- September 2017 

Pacific University, Claremont, CA 

• Promptly respond to 15-50 telephone calls and email questions per hour presented by faculty, staff, and students 

• Equip users with the information and skills necessary to effectively use campus wide technology 

• Assess and forward complex calls to specific information system specialists when needed 

 
Administrative Assistant May 2013- June 2015 

San Dimas Law Firm, San Dimas, CA 

• Recorded daily incoming payments to assist accounts receivable 

• Reconciled General Ledger with bank statements to ensure accurate records 

• Prepared bid reports and checked for accuracy upon submission 

OTHER EXPERIENCE 
 

Part-time Assistant Manager May 2014- July 2014 

The Body Shop, Arcadia, CA 

• Supervised part-time sales associates to encourage and ensure impressive customer service 

• Enthusiastically interacted with customers to meet their shopping needs 

• Calculated and recorded daily sales outcomes and submitted concise sales reports 

CLUBS & MEMBERSHIPS 
 

California Society of CPAs 

Financial Club, Vice President, Chaffey College 

Student Ambassadors, Member, Chaffey College 

Chronological Résumé Sample 
This resume lists your jobs and experience with your most recent work experience first. This resume is good for job seekers 

who have practical work experience with long periods of employment. 

mailto:anitajob@email.com
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Combination Sample 
This type of resume highlights your accomplishments and dates. Develop a resume that matches the key skill sets from the job 
announcement and focus on identifying transferable skills. 

 
 

 

JENNIFER M. STUDENT 
1234 N. E. Register Street, Upland, CA 91765 

909-555-1212 jennifer.student@gmail.com 
 

EDUCATION 

Chaffey College, Rancho Cucamonga, CA Anticipated: June 2020 
Associate of Science Degree in Business Administration 

• G.P.A. 3.7 
 

EXPERTISE INCLUDES: 

Technical: MS Excel, Word, PowerPoint, Access, QuickBooks Pro, Alpha/Numeric Filing, Google Docs 
Languages: Fluent English, Fluent American Sign Language, Conversational Arabic 
Interests: Business, Marketing, Management, Supervision 

 

PROFESSIONAL EXPERIENCE 

Administrative Support 
• Experienced in a variety of environments with expertise in administrative assistance, organization, and 

attention to detail 
• Well-developed communication skills and experience in handling multiline telephones along with 

balancing the demands of coordinating office responsibilities 
• Efficient, reliable and extremely thorough in all professional situations 

Customer Service 
• Excellent talent for reading the customer, collecting information, and providing appropriate solutions 

• Professional appearance with proficiency in greeting customers/clients and creating a comfortable 
environment 

• Strong problem-solving skills as well as extremely performance driven 
Leadership and Teamwork 

• Experienced in accepting a variety of projects and working them to completion in a team atmosphere or 
independently 

• Capable of taking on new tasks, accepting challenges, and providing solutions on all projects 
• Outstanding active listening and assessment skills with positive results-oriented solutions 

 

CAREER PROGRESSION 

Office Assistant • Imperial Tour and Travel • Ontario, California April 2018 – Present 
Receptionist • ABC Company • Upland, California May 2016 – April 2018 
Sales Associate • Aveda • Upland, California June 2014 – May 2016 

 

VOLUNTEER EXPERIENCE 

Building Assistant: Habitat for Humanity, Rancho Cucamonga, CA May 2016 – Current 
Volunteer: Brulte Senior Center, Rancho Cucamonga, CA May 2014 – June 2015 

mailto:jennifer.student@gmail.com
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Functional Resume Sample 

 
 

 
 
 

GABRIEL CHAFFEY 
 

(555) 555-3940  gabriel.chaffey@email.com  1420 College Way, Fontana, CA 92334 
 

 

SUMMARY OF QUALIFICATIONS 
 

Event planning professional with the energy and enthusiasm to pull off the perfect party. Detail-focused, 
friendly, and positive attitude with all staff, customers, and vendors. Patient with a proven ability to 
negotiate contracts and produce results on time. 

 

EDUCATION 
 

Chaffey College, Rancho Cucamonga, CA Expected Graduation: May 2020 
Associate Degree, Communications 

• Related Coursework: Interpersonal Communication, Fundamentals of Small Group 
Communication, Intercultural Communication, Business Law, Financial Accounting, Elementary 
Statistics 

 

SKILLS & INTERESTS 
 

Technical: QuickBooks, Microsoft Excel, MS Word, Google Docs 
Language: Fluent Arabic, Conversational Farsi 
Interests: Business, Accounting, Crafting, Photography 

 
 

HONORS AND AWARDS 
 

Chaffey College, Rancho Cucamonga, CA 
Dean’s Honors List Fall 2018, Spring 2019 
The Community Foundation Scholarship Fall 2018 

 
 

PROFESSIONAL ACCOMPLISHMENTS 
 

Planning & Coordination 
▪ Oversaw inventory control, ordering, and preparing for conference and wedding events 
▪ Consulted with clients to determine wants and needs of event 
▪ Practiced confidentiality with sensitive customer financial records and financial data 

Events Promotion 
▪ Assisted with planning, promoting and execution of special events 
▪ Proven ability to present excellent oral and written communication about events 
▪ Adept at handling multiple tasks in an organized manner ensuring 100% accuracy and fulfillment 

of event needs 
Building Relationships 

▪ Excellent working relationships with important clients while upholding company image 
▪ Experience interacting with vendors and building vital working relationships 
▪ Developed key relationships with customers to achieve high customer satisfaction levels 

Functional Resume Sample 
This type of resume focuses on skills and accomplishments. Functional resumes do not use dates associated with work history. 

mailto:gabriel.chaffey@email.com


9  

 
 
 

Charlie Chaffey 
7523 Harvard Ct. ▪ Rancho Cucamonga, CA ▪ 909-474-2973 ▪ ccchaffey@gmail.com 

 

Professional Summary 
Enthusiastic bilingual college student who enjoys providing leadership to support team members in accomplishing 

projects. Confident ability to collaborate effectively with diverse students, staff, and faculty while always 

displaying a respectful attitude. Organized and thorough in prioritizing tasks and completing them as scheduled. 

Education 
Associate in Arts Degree, Photography Anticipated Graduation: June 2017 

Chaffey College, Rancho Cucamonga, CA 

Related Coursework: History of Photography, Beginning Photography 

High School Diploma May 2015 

Ontario High School, Ontario, CA 

National Honors Society 

Skills 

Technical: 

• Microsoft Word, Excel, PowerPoint, Access, Internet, Google Docs, Prezi, Photoshop, Adobe 

• Social media: Facebook, Instagram, Snapchat, YouTube, Blogging, Vlogging 

Languages: 

• Fluent Spanish 

Community Involvement 
Volunteer, American Red Cross of Rancho Cucamonga October 2014-Current 

• Capture photos at local blood drive events following permission from signed release forms 

• Direct blood drive participants utilizing bilingual languages of English and Spanish 

• Coordinate with website designer in uploading of blood drive event photos to website 

Volunteer, Kiwanis Club of Rancho Cucamonga September 2013-June 2015 

• Planted trees in local neighborhoods to provide the community members with natural shade 

• Mentored youth who were involved in youth sports programs 

• Tutored youth in subjects of Math and English to increase their subject grades 

Extra-curricular Involvement 
Captain, Ontario High School Basketball Team June 2013-May 2015 

• Motivationally united team members towards achieving state championship qualification 

Treasurer, Ontario High School Key Club September 2013-September 2014 

• Responsibly managed funds to ensure club’s ability to attend events 

Achievements 
Volunteer of the Month, Kiwanis Club of Rancho Cucamonga 
Outstanding Leadership, Ontario High School Basketball Team 

Alternative Experience Resume 
This resume is good for job seekers who have volunteer, educational, and/or extracurricular experience and skills, but may lack 
work experience. 

mailto:ccchaffey@gmail.com
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Professional Profile Samples 

Professional Profile Samples 

OFFICE PROFESSIONAL 

 
 

GABRIEL CHAFFEY 
(555) 555-3940  gabriel.chaffey@email.com  1420 College Way, Fontana, CA 92334 

 

 

This section is optional. You may choose to do it as bullet points or as a sentence summary. Recommended for 
Alternative Resumes and Functional Resumes. 

 
All Professional Sections: 

• Emphasize what you can do. Non-transferable and transferable skills (i.e. technical skills, customer service 
skills, etc.). 

• Match your skills to the position for which you are applying for. 

• Match your skills to the organization’s mission statement, values, customer and/or product. 

• Use descriptive adjectives explaining your skills and expertise. 
 

Sentence Summary 
o No more than three sentences, and briefly describe yourself, experience, abilities, and 

strengths that are relevant to the position. 
Bullet Point Section 

o No more than 5 bullet points. 
 

 

SUMMARY OF QUALIFICATIONS 
Organized bilingual college student with strong administrative, accounting, bookkeeping skills. Ability to build 
strong relationships with colleagues and work with diverse populations. Team player with a competitive drive to 
excel professionally. Demonstrated efficiency to acquire new skills while meeting and exceeding deadlines. 

 
 

PROFESSIONAL PROFILE 

• Financial analysis, risk analysis and working knowledge of balance sheets 

• Highly proficient in MS Excel, Word, PowerPoint, Access, and internet tools 

• Innovative problem solver with an advanced ability clarifying problems and evaluating alternatives 

• Reliable, purposeful, and solutions oriented 

 

PROFESSIONAL SUMMARY 
Enthusiastic bilingual college student who enjoys providing leadership to support team members in accomplishing 

projects. Confident ability to collaborate effectively with diverse students, staff, and faculty while always 

displaying a respectful attitude. Organized and thorough in prioritizing tasks and completing them as scheduled. 
 

 

Dynamic, enthusiastic, and conscientious Office Professional with extensive experience in a variety of office 
environments and proven ability to work well with others in fast-paced working conditions. Highly 
motivated people-person with extensive expertise in the travel industry. Learn and adapt quickly and 
demonstrate excellent verbal and written communication skills. 

mailto:gabriel.chaffey@email.com
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CHOOSE YOUR RESUME SECTIONS 
 

 
Professional Profile 

Professional Summary 

Career Profile 

Summary of Qualifications 

Qualifications Summary 

Personal Snapshot 

Career Summary 

 

 
Areas of Expertise 

Areas of Knowledge 

Areas of Proficiency 

Areas of Excellence 

Areas of Strength 

Professional Skills 

Specialized Skills 

Career Related Skills 

Technical Experience 

Technical Skills 

Proficiencies Strengths 

Core Skills 

Core Competencies 

Skills Qualifications 

Software Proficiencies 

Language Competencies 

Professional Qualifications 

Technical Proficiencies 

Computer Skills 

Technology Skills 

 

 
Work Experience 

Related Employment 

Related Experience 

Career Experience 

Prior Experience 

Professional History 

Career Background 

Military Experience 

Freelance Experience 

Professional Experience 

[Industry] Experience 

Career History 

Career Highlights 

Relevant Experience 

Internship Experience 

Employment History 

Experience Highlights 

Career Achievements 

Professional Achievements 

Clinical Experience 

 

 
Educational Qualifications 

Academic Experience 

Academic Background 

Educational Training 

Formal Education 

Relevant Projects 

Education and Training 

Professional Training 

Related Coursework 

Related Projects 

Professional Development 

Continuing Education 

Licenses 

Credentials 

Certifications 

Apprenticeships 

Education 

Internships 
 

 
Honors and Awards 

Academic Honors 

Recognitions 

Achievements 

Accomplishments 

Notable Achievements 

Scholarships 
Special Recognition 

 

 
Professional Memberships 

Leadership Experience 

Volunteer Experience 

Professional Associations 

Community Involvement 

Civic Involvement 

Associations 

Extra-Curricular Activities 

Community Activities 

Memberships 

Athletic Involvement 

Community 

Leadership and Service 

Extra-Curricular Involvement 

Reinvestment 
Publications 

Volunteer Contributions 

Presentations 

Published Articles 

Volunteer Affiliations 

Conventions 
Conference Presentations 

EXTRA-CURRICULAR 

AWARDS AND RECOGNITION 

EDUCATION AND TRAINING 

WORK AND EMPLOYMENT 

SKILLS 

PROFILE 
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ACTION VERBS FOR YOUR RESUME 

Bullet Point Formula: ACTION VERB + JOB RESPONSIBILITY + RESULT WHY 
 

 
ADMINISTRATIVE SKILLS: 

Assisted Checked Copied (Paperwork) Created Filed Planned Wrote 
Back managed Analyzed Duplicated Creatively Designed Assorted Arranged Accurately logged 
Co-facilitated Assessed Photocopied Developed Catalogued Coordinated Documented 
Collaborated Evaluated Produced Established Categorized Organized Entered 

Partnered with Examined Replicated Generated Classified Prepared Inputted 
Supported Reviewed Reproduced Produced Labeled Scheduled Recorded 

HELPING AND CUSTOMER SERVICE SKILLS: 
Answered Helped Met (Sales Goals) Promoted Sold Stocked Talked 

Effectively solved Provided Achieved Actively Promoted Assisted w/purchases Accounted for Addressed 
Reconciled Recommended Fulfilled Advertised Generated sales Catalogued Approached 
Resolved Referred Satisfied Strategically displayed Increased profits Inventoried Contacted 
Settled Suggested Steadily reached Marketed Processed transactions Recorded Greeted 

Successfully satisfied Supported Successfully completed Eagerly presented Optimized sales Itemized Recorded 

TECHNICAL AND HANDS-ON SKILLS: 
Built Fixed Maintained Operated Set-up Shipped Remodeled 

Assembled Refurbished Conserved Controlled Adjusted Delivered Modernized 
Constructed Renovated Preserved Directed Automated Distributed Modified 
Developed Repaired Retained Skillfully guided Coded Imported/Exported Refashioned 
Installed Restored Sustained Maneuvered Encoded Supplied Renovated 

Manufactured Revamped Upheld Piloted Programmed Transported Transformed 
Designed 

Fabricated 
Overheard 

Solved 
 Engineered 

Computed 
Calculated  Upgraded 

Optimized 

RESTAURANT SERVICE SKILLS: 
Cooked Handled Prepared Served Took Orders Cleaned Stocked 

Delicately fried Controlled cash flow Arranged Attended to Inputted Diligently washed Inventoried 
Evenly baked Managed complaints Prepped Catered Obtained Disinfected Proactively Stocked 

Sautéed Operated equipment Ordered Eagerly served Processed Meticulously cleaned Refilled 
Flambéed Processed payments Organized Provided for Readily accepted Sanitized Reordered 

Thoroughly grilled Supervised staff Planned Waited on Accurately recorded Thoroughly rinsed Replenished 

TEACHING AND CHILDCARE SKILLS: 

Disciplined Increased (scores) Led (activities) Talked to (parents) Taught Washed Watched 
Corrected behavior Enhanced Coordinated Consulted with Demonstrated Disinfected Cared for 

Enforced policies Improved Directed Discussed with Educated Thoroughly laundered Monitored 
Mediated conflicts Steadily raised Facilitated Informed Instructed Carefully cleaned Observed 

Positively reinforced Strengthened Enthusiastically Notified Modeled Sanitized Actively oversaw 
Redirected students Substantially Organized Updated Reinforced concepts Sterilized Supervised 

 boosted Guided Advised Trained   
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 LEADERSHIP SKILLS:  

Accomplished Chaired Directed Impacted Oversaw Planned Strengthened 
Achieved Consolidated Earned Increased Planned Predicted Supervised 

Administered Contacted Evaluated Led Predicted Prioritized Surpassed 
Analyzed Coordinated Executed Mastered Prioritized Produced  

Assigned Delegated Handled Orchestrated Produced Proved  

Attained Developed Headed Organized Proved   

ORGANIZATIONAL SKILLS: 
Approved Changed Dispatched Inspected Purchased Simplified Unified 

Accelerated Classified Executed Launched Recorded Sold Updated 
Added Collected Expanded Monitored Reduced Specified Utilized 

Arranged Complied Gained Operated Reinforce Steered Validated 
Broadened Completed Gathered Organized Retrieved Structured Verified 
Cataloged Controlled Generated Prepared Screened Systemized  

Centralized Defined Implemented Processed Selected Tabulated  

COMMUNICATION SKILLS: 
Addressed Convinced Documented Formulated Mediated Promoted Spoke 
Arbitrated Corresponded Drafted Influence Moderated Publicized Suggested 
Arranged Delivered Edited Interpreted Negotiated Reconciled Synthesized 
Authored Developed Energized Lectured Persuaded Recruited Translated 

Collaborated Directed Enlisted Liaised Presented Reported Verbalized 
     Rewrote Wrote 
   RESEARCH SKILLS:    

Clarified Constructed Diagnosed Extracted Interpreted Organized Surveyed 
Collected Critiqued Discovered Formed Interviewed Resolved Systemized 

Concluded Derived Evaluated Identified Investigated Reviewed Tested 
Conducted Determined Examined Inspected Modeled Summarized  

QUANTITATIVE SKILLS: 
Administered Appraised Budgeted Developed Managed Minimized Projected 

Allocated Audited Calculated Forecasted Maximized Planned Researched 
Analyzed Balanced Computed     

   CREATIVE SKILLS:    

Acted Created Directed Illustrated Introduced Planned Revitalized 
Composed Customized Established Initiated Invented Published Shaped 
Conceived Designed Fashioned Instituted Organized Redesigned Visualized 

Conceptualized Developed Founded Integrated Performed Revised  
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  Transferable Skills Checklist  

Key Transferable Skills 
 Meet deadlines & goals 
 Ability to delegate 

 Ability to plan 

 Results oriented 

 Customer service oriented 

 Supervise others 

 Increase sales or efficiency 

 Accept responsibility 

 Instruct others 

 Desire to learn & improve 

 Good time management 

 Solve problems 

 Manage money/budgets 

 Manage people 

 Gather information 

 Organize people 

 Organize/ manage projects 

 Team player 

 Written communications 

 Work independently 

 Computer skills 

 

Working with things 

 Hand-eye coordination 

 Assemble or make things 

 Safety conscious 

 Build, observe, inspect 

things 
 Construct or repair 

 Off-bearing or feeding 

machinery 
 Follow instructions 

 Operate tools and 

machinery 
 Drive or operate vehicles 

 Repair things 

 Good with my hands 

 Use complex equipment 

 Use equipment 

 
Using words, ideas 

 Articulate 

 Innovative 

 Speaking effectively 

 Logical 

 Remember information 

 Accurate 

 Research 

 Create new ideas 

 Design 

 Public speaking 

 Edit 

 Write clearly and concisely 

 Conceptualize ideas 

 Understand the big picture 

Working with Data 

 Analyze data or facts 

 Investigate 

 Audit records 

 Keeping financial 

records 
 Interpret information 

 Locate answers or 

information 
 Balance money 

 Calculate, compute 

 Manage money 

 Classify data 

 Compare, inspect, or 

record facts 
 Count, observe, compile 

 Research 

 Detail-oriented 

 Take inventory 

 
Working with people 

 Patient 

 Care for 

 Persuading others 

 Conflict resolution 

 Pleasant 

 Counsel people 

 Sensitive 

 Demonstrate something 

 Supportive 

 Diplomatic 

 Supervise 

 Facilitating group 

discussions 

 Help others 

 Tactful 

 Insightful 

 Teach 

 Interview others 

 Anticipate needs 

 High energy 

 Open minded 

 Kind 

 Take orders 

 Listen 

 Serving 

 Trust 

 Developing rapport with 

others 
 Negotiate 

 Understand 

 Adaptable 

 Outgoing 

Leadership 

 Arrange social functions 

 Motivate people 

 Negotiate agreements 

 Decisive 
 Plan & coordinate tasks 
 Delegate 

 Run meetings 

 Direct others 

 Explain things to others 

 Self-motivated 

 Gets results 

 Share leadership 

 Think of others 

 Direct projects 

 Team builder 

 Solve problems 

 Mediate problems 

 Take risks & challenges 

 Empowering others 

 
Creative, Artistic 

 Artistic 

 Musical 

 Dance, body movement 

 Perform, act 

 Draw, sketch, render 

 Present artistic ideas 

 Play instruments 

 Expressive 

 Imaginative 

 Storytelling 

 
Add any other transferable 

skills that you think are 

important 

   

   

   

   

   











 



 

 

Quick Tips - Formatting Resume in Word 
 

Margins 

Set page margins 

• Click the Layout Tab 

• Select the Margins Dialgog Box in the page setup 

group 

o Choose preset margins or customize them 
▪ Margins should be between .5” to 1” 

 

 
Paragraph Alignment 

Set where your text will appear 

• Click the Home Tab 

• Choose the button alignment on the paragraph group. 

o Align Left: text is aligned with the left margin 

o Center: text is centered within your margins 

o Align Right: text is aligned with the right margin 

 

Example: 

Chaffey Student 

 
Line Insert 

Add a line under a header 

• Click the Home Tab 

• Highlight the text you want the border under 

• Select the Borders Dialog Box in the paragraph group 

o Select the bottom border option 

EXAMPLE 

 

Setting Tabs 

Use the ruler to manually set tab stops in your document 

• Click the View Tab 

• Click/check the Ruler box in the show group 

• Set tabs by clicking the tab selector at the left end of the ruler until it displays the type of tab you 

want and then clicking the ruler at the location you want. 

o Left Tab stop sets the start position of text that will go to the right as you type 

o Center Tab stop sets the position of the text in the center as you type 

o Right tab stop sets the right end of the text that will go on the left 
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Resume Language, Formatting, and Tips: 
 

✓ Keep your resume length to one page, unless there is more than 7 to 10 years of relevant work 

experience. 

✓ Margins should be between 1” and .5”. 

✓ Font size should be no smaller than 10pt. 

✓ Do not use a resume template, they are difficult to reformat. 

✓ Avoid excessive use of italics, CAPS, and bold. 

✓ Fonts should be professional and clearly legible. 

✓ Avoid using pronouns, such as “I,” “we,” “my,” and “our.” 

✓ Use present tense for your current positions and past tense for past positions. 

✓ Spell out acronyms and avoid abbreviations. 

Each resume must be tailored to the specific position you are applying for! 

Contact Information 
 

• Include full name (BOLD and at least 14 pt. font), home address, city, state, zip code, and best contact telephone 

number. 

• Be sure to list a professional email address (example: firstname.lastname@email.com) 

Professional Profile Section 
 

• Professional profiles are no more than three sentences, and briefly describe yourself, experience, abilities, and 

strengths that are relevant to the position. 

• Employers no longer want to see an objective. However, if you do decide to use an objective, be sure that it is 

specific to the position (include name of position and employer) in which you are applying for. 

Education Section 
 

• List most recent or current school first (include Chaffey College). Include name of school, city, state and date or 

expected date of graduation. 

• Be sure to spell out major and the degree working towards. 

• List GPA if 3.5 or above. 

• Only include high school if you’ve been out less than two years. 

• Can include relevant coursework and class projects that relate to career objectives or position you are applying to. 

Experience Section (Related Experience) 
 

• List jobs and work experience directly related to the position you’re applying for. 

• 3-5 bullet points, staring with an ACTION VERB (ex. Promptly respond), JOB DUTY (ex. to 15-50 telephone 

calls and email questions), and RESULT (ex. per hour presented by faculty, staff and students) 

Other Sections and Ideas to add to your Resume 
 

• Additional work experience (unrelated to the position), volunteer, and leadership experience can be listed here. 

• Clubs, organizations, affiliations, honors, awards and special talents. 

• Skills, such as computer and typing skills, knowledge of specific software programs, and languages. 

• List specialized certifications (example: Food Handlers certificate, CPR/First Aid) and provide expiration dates if 

applicable. 

Resume Do’s Resume Don’ts 

• Maintain current contact information 

• Use data to describe experience 

• Continuously update your resume 

• Include relevant key words specific to the 

position 

• Be honest 

• Include employer addresses, supervisor names 

and salary information 

• References, photographs, disclosing personal 

information (i.e. age, marital status, etc.) 

• Use jargon, slang and conjunctions 

• Lie or exaggerate 
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